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Session 1
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Opening Session

• Opening Remarks: objectives, expectations
• Modalities, Procedures and Guidelines for Transparency 

Framework of Paris Agreement 
• Reporting requirements to estimate GHG emissions from 

anthropogenic sources (Energy - Road Transportation) 

UNFCCC Secretariat 



Quiz on Mentimeter 
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Challenges faced by developing countries to estimate GHG 
emissions from road transportation in line with 2006 IPCC GLs 

https://www.menti.com/alst8x8wzy7b

Mentimeter code: 5948 7113
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Overview of road transportation in developing countries

Learning 

objectives

By the end of this session, you will know more
about :
1. Different contexts of road transportation data in

developing countries
2. Constraints and difficulties for data collection

from road transportation
3. Data needs to improve GHG emission estimates

from road transportation



Trend of vehicles in use by region between 2000 - 2018

Source: World Road Statistics



History of data development for road vehicles

• Vehicle manufacturer (safety and environmental
regulations, compliance)  

• Legal framework developpment
• Civil society (Pressure groups) and governance
• Traffic management and road infrastructure 

investment
• Air quality control and health protection 
• Environmental protection awarness
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Different contexts of road transportation data

- Activity Data (Fuels, Vehicle stock)
- Unit Emission Factors (Fuel, Vehicle)
- Vehicle fleet characterization
- Driving conditions and parameters 

⃰ Developed countries: vehicle manufacturer, regulations 
(implementation of emission standards), fleet and traffic 
observatories, professional associations, scientific research, 
etc.

⃰ Developing countries: importer (new, used), vehicle 
assembler, absence of standards, absence of observatories, 
weak scientific research, etc.



Lack of data in developing countries                        1/2

Vehicle fleet composition, annual mileage and traffic characteristics

• Weak Vehicle Registration Systems: fragmented, decentralized with
gaps or inaccuracies in recorded data

• Limited Institutional Capacity: lack of resources, expertise, and 
technology to maintain accurate and comprehensive records (updating) 

• Lack of Data Collection Infrastructure and management: requires
investment which is not prioritized over issues such as poverty
reduction, health, and education

• Limited Financial and human Resources for Surveys and Studies: 
collecting accurate vehicle mileage and other road vehicle driving
parameters data require extensive surveys.



Lack of data in developing countries                    2/2

Vehicle fleet composition, annual mileage and traffic characteristics

• Infrequent Vehicle Inspections: I/M is poorly enforced, or absent, data collected is not 
always centralized or properly utilized.

• Adoption of Emission Standards with Inconsistent Implementation: Several countries 
adopted pollutant emission standards (Euro, US standards or equivalents) but not fully
implemented, Fuel quality regulations to reduce the sulfur content for enabling
vehicles to meet emission standards but partially implemented and fuel composition 
data not collected.

• Challenges with Imported Used Vehicles: incomplete or inadequate data recorded



Challenges for data collection                              1/2                                                              
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1. Vehicle Fleet Data: Lack, limited or outdated records of vehicle fleets (Data on 
vehicle types, fuel types, age, technology, emission standards and usage patterns 
are often incomplete or unavailable).

2. Fuel Consumption Data and characteristics: Lack of accurate data on fuel sales, 
fuel usage and fuel quality (fuel composition).

3. Traffic and Road Use Patterns data: Lack or poor data on vehicle road traffic 
(speed and mileage per vehicle category and road type).



Challenges for data collection                              2/2
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4. Emission Factors: Lack of country specific emission factors, use of default EFs 
which may not be appropriate for the vehicle technologies and national 
driving conditions.

5. Vehicle Types: Lack of data on aging and maintenance per vehicle category.

6. Low technical Expertise: Lack trained personnel and institutions to develop 
comprehensive GHG inventories.



Session 3
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2006 IPCC GLs for estimating GHG emissions from road 
transportation 

Learning 

objectives

By the end of this session, you will :

1. Know all about the IPCC methodologies to 
estimate GHG emissions from road 
transportation 

2. Understand the different tiers (T1, T2, T3) 
3. Identify the needed data to move to higher tier 

to estimate GHG emissions   



Road Vehicles
Movement of goods

and/or passengers

Evaporative Emissions Exhaust

Emissions

Road vehicle

tyre and brake

wear

Road wear 

caused by 

vehicles

motion
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Sources of pollutant emissions from road transport



Sources of pollutant emissions from road transport

IPCC Category: 1 A 3 b v

IPCC Category: 1 B 2 a 5

IPCC Category: 1 A 3 b i-iv
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IPCC 2006 Classification: Fuel combustion  



1.B: Fugitive emissions
from oil/natural gas
systems

1.B.1: Solid Fuels 

1.B.2: Oil, natural gas
and other emissions
from energy production 

1.B.2.b: Natural gas

1.B.2.c: Other

1.B.2.a: Oil

1.B.2.c: Venting & flaring

1.B.2.a.2 Production 

1.B.2.a.1 Exploration  

1.B.2.a.4
Refining/Storage 

1.B.2.a.3 Transport 

1.B.2.a.6 Other

1.B.2.a.5 Distribution 
of oil products
(Previous 1.B.2.a.iii.5) 

IPCC 2006 (Refinement 2019) : Classification of  
fugitive emissions of fuels  



Fundamental Concept of GHG Emission Estimation  

Emission = Activity Data (AD)  X  Emission Factor (EF)

Fuels 

VKT 

Emissions  

FE (kg/TJ)

FE (g/km)

CO2, CH4, N2O

CO2, CH4, N2O

Sold

CO2, CH4, N2O (kt)

Vehicle stock
Traffic characteristics



Activity Data required

1- Statistics on Fuel consumption:

- Fuel type, composition 

- Vehicle category

- Vehicle technology

2- Statistics on traffic characteristics

- Total annual mileage

- Average Speed

- Road type  

3- Statistics on vehicle stock 

- Vehicle category (fuel type)

- Vehicle technology



Decision tree for 

CO2 emissions 

from fuel 

combustion in 

road vehicles

IPCC 2006, Vol. 2, Chap. 3, Fig. 3.2.2 
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IPCC 2006 
decision tree for 
estimating CO2, 
CH4 and N2O 
emissions from 
road vehicles

IPCC 2006, Vol. 2, Chap. 3, Fig. 3.2.3 
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Where:
Emission = Emissions of CO2 (kg)
Fuela = Fuel sold (TJ)
EFa = Default EF (kg/TJ). This is equal to the carbon content of 

the fuel multiplied by 44/12
a = type of fuel (e.g. petrol, diesel, natural gas, LPG, etc.)

Tier 1: CO2 emission

IPCC 2006, Vol. 2, Chap. 3, Eq. 3.2.1 
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Where:
Emission = Emissions of CO2 (kg)
Fuela = fuel sold (TJ)
EFa = Country specific EF (kg/TJ). This is equal to the CS

carbon content of the fuel multiplied by 44/12.
a = type of fuel (e.g. petrol, diesel, natural gas, LPG etc)

Tier 2: CO2 emission

IPCC 2006, Vol. 2, Chap. 3, Eq. 3.2.1 
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Where:

Emissions = Emission in kg

EFa = Default emission factor (kg/TJ)

Fuela = Fuel consumed (TJ) (represented by fuel sold)

a = Fuel type a (e.g., diesel, gasoline, natural gas, LPG)

Tier 1: Emission of CH4 and N2O 

IPCC 2006, Vol. 2, Chap. 3, Eq. 3.2.3 
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Where:
Emission = emission in kg
EFa,b,c = emission factor (kg/TJ) (Tier 2, USA)
Fuela,b,c = fuel consumed (TJ) (represented by fuel sold) for a given mobile

source activity
a = fuel type (e.g., diesel, gasoline, natural gas, LPG)
b = vehicle type
c = emission control technology (such as uncontrolled, catalytic

converter, etc)

Tier 2: Emission of CH4 and N2O 

IPCC 2006, Vol. 2, Chap. 3, Eq. 3.2.4 
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Where:
Emission = emission or CH4 or N2O (kg)
EFa,b,c,d = emission factor (kg/km) (Tier 3, COPERT model)
Distancea,b,c,d = distance travelled (VKT) during thermally stabilized engine (km)
Ca,b,c,d = emissions during warm-up phase (cold start) (kg)
a = fuel type (e.g., diesel, gasoline, natural gas, LPG)
b = vehicle type
c = emission control technology (such as uncontrolled, catalytic converter, etc.)
d = operating conditions (e.g., urban or rural road type, climate, or other

environmental factors)

Tier 3: Emission of CH4 and N2O 

IPCC 2006, Vol. 2, Chap. 3, Eq. 3.2.5 



Conclusions from 2006 IPCC GLs

CO2

CH4 & N2O

Tier 1:
- Fuel consumption (sold) 
- Default EF

Tier 2:
- Fuel consumption (sold) 
- Country Specific EF

Tier 1:
- Fuel consumption (Sold) 
- Default EF

Tier 2:
- Fuel consumption (Sold) 
- EF by technology

Tier 3:
- Distance travelled
- EF disaggregated (COPERT)
- Cold emissions

!

!
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Tuesday 24 September 2024

15:00 – 17:00 (Bonn Time) 
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Higher tier methods for estimating GHG emissions from road 
transportation
COPERT model: interface and functions

Learning 

objectives

By the end of this session, you will:
1. Know more on Copert model features, 

requirements and installation   
2. Discover the Copert Interface, 
3. Identify the different functionalities
4. Understand the different modules & menus  
5. Know more on the data needed to run it



- COPERT: COmputer Program to calculate Emissions from Road 
Transport

- COPERT version 5.7.3 (latest version)
- European tool for the calculation of emissions from the road 

transport sector (EEA & JRC funded)
- Scientifically and technically supported by Emisia and the 

Laboratory of Applied Thermodynamics, University of 
Thessaloniki, Greece

- COPERT methodology is consistent with the 2006 guidelines for 
the calculation of GHG Emissions

30

COPERT: Description 



- It uses vehicle stock, mileage, speed and other data such as 
ambient temperature and calculates emissions and energy 
consumption for a specific country or region.

- Covers all classes of road vehicles
- Calculates emissions of all pollutants from road transport

• regulated pollutants: CO, NOx, VOC, PM) and CO2,
• unregulated pollutants (N2O, NH3, SO2, NMVOC, etc.)

- Calculates fuel consumption
- Applicable in all countries of the world

31

COPERT: Uses & application  



32

COPERT usage in the world (2021)
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Copert Users: Continent Distribution (2021)

Based on ~800 unique 
downloads/year

Giorgos Mellios | 2021-06-14
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COPERT Users (2021): Distribution by activity

Giorgos Mellios | 2021-06-14
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COPERT Applications (2021)

Giorgos Mellios, 2021-06-14 



COPERT installation Requirements



Download and install Copert Model 



Download and install Copert Model 

Demonstration online: 
https://copert.emisia.com/ 



Launching Copert for the first time 
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COPERT 5 Interface
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Selection of the Tier mode: Tier 2 or Tier 3 
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Interface COPERT 5.7.3

COPERT 5 Interface

Menu
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COPERT model estimation procedure Tier 2

The COPERT model 
was developed to 
calculate the 
amount of 
pollutant emissions 
per vehicle or fleet 
for a year



44

COPERT model estimation procedure Tier 3

The COPERT model 
was developed to 
calculate the 
amount of 
pollutant emissions 
per vehicle or fleet 
for a year
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Comparison of Copert data input between Tier 2 vs Tier 3 

Tier 2 Tier 3

File > Create File > Create

Year > Add Year Year > Add Year

Properties > Environmental Information Properties > Environmental Information

Fuel > Advanced Specifications

Fuel > RVP

Vehicles > Stock Configuration Vehicles > Stock Configuration

Vehicles > Stock & Activity Data Vehicles > Stock & Activity Data

Vehicles > Circulation Data

Calculate Emissions (Factors, Results, Timeseries Results)

Energy Balance (optional)  
Fuel > Statistical Consumption
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RVP: Reid Vapor Pressure (tension 
de vapeur)

Flow chart of the 

application of 

the COPERT 

baseline 

methodology



47

Interface COPERT 5.7.3 (Tier 2)
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COPERT 5.7.3 interface
Detailed Menu of Tier 2
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COPERT 5.7.3 (Tier 3)
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COPERT 5.7.3 Interface 
Detailed menu of Tier 3



After creating or opening an inventory file, one can use a wizard, which performs 
the basic steps in order to produce and calculate a complete run.

Just press 'Next' and follow the instructions

51

Wizard execution



Country > add country 

52

File > Create

The methodology for the 
calculation of exhaust emissions 
may follow Tier 2 or Tier 3. In 
Tier 2 methodology, the 
calculations take into account 
the amount of fleet and the 
vehicle kilometers per 
technology while in Tier 3, 
emission factors are mode 
detailed and they depend also 
on temperature profile, driving 
pattern, parking pattern, and 
other activity parameters. 

Label only, does  not 

affect  calculations
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Year > Add Year

Label only, does  not 
affect  calculations
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Properties > Environmental Information

Import to and from Excel  

(functionality exists in all  

forms)
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Properties > min et max temperatures et RVP 

The user may provide values for monthly average minimum and maximum temperatures. These values 
may be different for every year. 
The user may provide the relative humidity per month. This is required to calculate the load of air-
conditioning (A/C) and the fuel evaporation. A high value denotes high humidity and a higher load for the 
A/C that increases consumption.
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Properties > Trip Characteristics

The user may change 
the country's average 
Trip Length in km and 
Trip Duration in hours 
for each vehicle 
category or keep the 
default values.
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Fuel > Specifications

The user may provide data for the Fuel specifications (energy content and fuel density) or keep the default 

values and Values for several heavy metal content and O:C ratio are also proposed. 

Those values may change if more accurate figures are available. These data can be different every year. 

COPERT default  

values



COPERT default

values
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Fuel > Advanced Specifications
The user may provide data the Advanced Fuel Quality Specifications and choose between four fuel 
types: 1996 (Base Fuel), 2000 (Stage 2000) and 2005 (Stage 2005), 2009 (Stage 2009) from the Fuel 
Year drop-down list.
The default value is 1996. If this option is selected then all vehicles are assumed to operate on a 
conventional – Base – fuel (corresponding to 1996 EU15 market average). 
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Fuel > Statistical energy consumption

The user may provide the statistical energy 
consumption in case he/she wants COPERT to 
perform an energy balance. Providing values 
is not enough for taking into account 
statistical energy consumption, the user also 
has to select to "perform automatic energy 
balance". 
Data provided here are for primary fuels only, 
and there is an option to provide 2 different 
Petrol, Diesel, and LPG energy consumption 
values if such information exists. 
Different values denote that in the 
Fuel>Specifications form different fuel 
characteristics have been provided by the 
user.
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Fuel > RVP (Reid Vapor Pressure)

The user may provide the 

Reid Vapor Pressure for 

each month in kPa. 
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Fuel information

The user may provide the statistical energy 
consumption in case he/she wants COPERT to 
perform an energy balance 
The user also has to select to "perform automatic 
energy balance"

The user may provide data for the Fuel 
specifications such as energy content and 
fuel density or keep the default values, also 
the hydrogen to carbon atom ratio (H:C 
ratio)
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Vehicles > Stock Configuration

This window represents one of the necessary inputs
the user selects which types of vehicles will be in the fleet of the selected year
The user may also apply the fleet configuration to other years of the selected run by checking the "All 
years" option at the bottom of the form
The user may also export the categories to an excel/CSV file. When the configuration is complete press 
OK and the appropriate data will be updated 
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Vehicles > Stock & Activity Data

Exercise data

This window represents one of the necessary inputs
The user types (or imports) input data for Stock, Mean Activity (km/year), and Lifetime Cumulative Activity 
(km)
The user is able to import/export these data from/to an excel/CSV file, and there are also the options of 
undo/redo available
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Vehicles > Circulation Data

Exercise data

This window represents one of the necessary inputs
The user types (or import) the average speed(which should be within the given range in the last 
column) and the mileage percentage (sum should always be 100%) driven by each vehicle 
technology per driving mode
To filter vehicle sectors use the Sector drop-down list in the top left corner of the form 
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Vehicles > Fuel Evaporation Data
We can find input data for Fuel Tank Size (l), Canister size (l), percentage of vehicles equipped with Fuel 
Injection (%), percentage of vehicles equipped with Evaporation Control (%), and the distribution of 
evaporative emissions to different driving modes (%)
To enter your own values, simply replace the proposed value by typing in the corresponding cell
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Vehicles > Driving Conditions

Window representing the driving conditions (loads of heavy vehicles and buses and road slopes) of 
the different traffic modes 
A default value of 50% is given and this corresponds to the baseline emission factors of COPERT 
The slope factors are calculated and applied during the calculation of the hot emission factors 
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Vehicles > A/C Prametres

The user may provide the vehicles 
equipped with air-conditioning system 
(Vehicles equipped with A/C(%). Some 
'default' values are proposed which are 
rough estimates only 
For simplicity, one single usage factor is 
proposed regardless of urban, rural, or 
highway driving 
This usage factor is uniformly applied to 
all driving conditions 
This usage factor should be integrated 
over the year, i.e. there is no seasonal 
differentiation 
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Factors > Hot, Cold and evaporation emission
factors and Beta factors

Exercise data
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Results > Total Emissions

Data of exercise

The results for all pollutants, vehicle types, driving modes and emission types (hot, cold, evaporation, A/C, 
Lubricant, Tyre, Brake Wear, Road abrasion) are calculated by COPERT and cannot be modified by the user

The user can by appropriately placing the drop-down lists to group and filter the available information 
The user can make export directly from the form to and from an Excel or csv file 

Select 
pollutant

Export to 
Excel 

Show all digits
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Results > Implied Emission factors

Exercise Data

This pivot table form indicates the 
implied emission factors for all 
pollutants and energy consumption in 
g/km or MJ/km
Please note that these are implied 
emission factors, which means that 
they are dependent not only on the 
traveling speed but also on the fleet 
configuration and input data (eg
temperatures) of each run 
Data are not updatable
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Results > Specification of NMVOC Emissions

Exercise

data

In this Pivot table form, the Non-methane volatile organic compounds (NMVOCs) are displayed for 
all vehicle types and emission types (hot, cold, evaporation) and cannot be modified by the user 
The user can by appropriately placing the drop-down lists to group and filter the available 
information 
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Results > Energy & GHG breakdown

Exercise

Data

This is a new feature in COPERT 
In this pivot table form, there is an extra level of information for the results regarding the origin of each 
primary fuel (bio/fossil) for Energy Consumption (EC) and GHG (CO2, CH4, N2O) for all vehicle types 
The user can by appropriately placing the drop-down lists to group and filter the available information 
The user can make export directly from the form to and from an Excel or csv file 
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Parameters > Hot parameters

The user can view and edit the hot emission parameters that are used for the calculation of the hot 
emission factors in the Factors>Hot 
The parameters are displayed for each pollutant and vehicle type 
Different parameters may also apply in the case of different driving modes
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Parameters > Cold parameters

The user can view and edit the cold emission parameters that are used for the calculation of the cold 
over-emission factors in the Factors>Cold 
The parameters are indicated for each pollutant and vehicle type 
Different parameters may also apply in the case of different driving modes 
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Exchange > Export Input Structure, Factors and 
Results in Excel

This form indicates a list of years included in the inventory and another list of the required input data 
By clicking on the corresponding check box the user can select which information he/she wants to export 
to an Excel file 
For compatibility reasons both Excel 2010 and Excel 2003 formats can be selected 
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Exchange > Import Input Data (Excel File)

By clicking on the corresponding 
check box the user can select which 
input information he/she wants to 
import from an Excel file and for 
which years 
For compatibility reasons, both 
Excel 2010 and Excel 2003 formats 
can be selected 



77

Exchange > CRF Export (CRT MPGs/Accord Paris)

Export data to the CRF file after calculating emissions from all years 
Before performing any export, the user should export the corresponding excel template (including the 
structure/nodes and the years) from the CRF reporter 
Select the year(s) and the relevant information (i.e. activity data, emissions etc) that he/she wishes to export 
By clicking the option “Clear all excel years” all information included in the file (as exported by the CRF 
reporter) will be erased 
In order to upload the exported data to the CRF Reporter, this empty file should be imported in the CRF 
Reporter
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Timeseries Results > Total Emissions - Timeseries

This is the same pivot form as the Results>Total Emissions form with the difference that the user can 
have an overview of all results for the complete timeseries, if exists in the file 
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Timeseries Results > Implied Emission Factors -
Timeseries

This is the same pivot form as the Results>Implied Emission Factors with the difference that the 
user can have an overview of all results for the complete timeseries, if exists in file



Conclusions
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COPERT interface and functions : 

• Can be utilized by all countries 
• Calculating emissions of all pollutants from road 

transportation (GHG, Precursors, NMVOCs) 
• All categories of road vehicles covered 
• Fuel consumption calculated (energy balance)



Day 3 
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Wednesday 25 September 2024

15:00 – 17:00 (Bonn Time)
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Higher tier methods for estimating GHG emissions from 
road transportation
COPERT model: input data and database construction

Learning 

objectives

By the end of this session, you will:

1. Get familiar with the different menus, buttons
and options

2. Data entry and use of different structure of
databases

3. Identify difficulties while using Copert features



• Data input of all activity data (fleet, circulation and
evaporation data) can be done in 3 ways:
A. Direct data entry Input (Manually): with and 

without Wizard  
B. Imported from Microsoft Excel
C. Imported from COPERT

83

Entry of activity data



• Enter activity data directly via the forms under the ‘Vehicles’ menu:
✓ Stock & Activity Data
✓ Circulation Data
✓ Fuel Evaporation Data

• Open each form; fill the desired values for every vehicle category

84

Direct data Input 1/3
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Direct data Input 2/3

The information is provided by the user or calculated by COPERT and can be 
modified by the user
A modified value will be displayed in red color, and if the "Apply" button is pressed, 
this color changes to the default color, which is black

All forms are equipped with "Undo" and "Redo" buttons and import and export 
buttons directly from the form to and from an Excel or csv file
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Direct data Input   3/3

1. Data entry on COPERT interface (Tier 2 & Tier 3)
2. Export of data entered on COPERT (Tier 2 & Tier 2) 

to Excel file
3. Modification of data (Tier 2 & Tier 3) in Excel file
4. Import modified (Tier 2 & Tier 3) Excel data file to 

COPERT



• Import data from Excel file

• Open the form ‘Vehicle’>Stock & Activity Data'> 'Import (Format 
Excel File)'
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Import Data from Microsoft Excel file (1/4)



1. Select Exchange > Import Input Data (Excel file)’
2. Select the year or years (if there are several)
3. Select the data you wish to import (list of ‘Input Data’) by checking the 

corresponding boxes

88

Import Data from Microsoft Excel file (2/4)



• Open the Excel file created
• Every selected data type is a

different  sheet in the Excel file

• Every selected vehicle category 
is a  row

• Every selected year is a column

89

Import Data from Microsoft Excel file (3/4)



• Fill the cells of the year columns with 
the desired values

• For example, the mileage for the year 
'2004' of a vehicle category is 10,000 
km

• Leave a cell empty if you want the 
database data value not to be changed

Note: 
If a vehicle category does not  exist in a fleet 
configuration of a  specific year then the cell of the  
Excel file will have the value  'not exists'. You should not  
change that value

After you fill the desired values  save and close the
Excel file
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Import Data from Microsoft Excel file (4/4)



Show all numbers

Select
Pollutant

Export to Excel

91

Results > Implicit emissions factors



The final step is to export all the emissions
Open the 'File > Import/Export > Create Import Format Excel File' form

92

Export Data to Microsoft Excel file



Hands-on exercises to enter, select and modify data

Online demonstration using COPERT



1. Fleet (vehicle fleet in operation per category)

A. Passenger transport (passenger cars, buses, L-category vehicles)

B. Freight transport (light commercial vehicles, heavy duty trucks)

C. Split per fuel (energy) type, segment subcategories, and technologies/Euro 
standards

2. Mileage: Average annual distance driven [km/vehicle]

3. Speeds: Average travelling speeds in urban, rural, highway modes [km/h]

4. Activity shares: Share of activity in urban, rural, highway modes [%] 

5. Temperatures: Country average [°C] 

6. Fuel consumption: sales (Statistics) [TJ]
- Energy content of primary fuels [MJ/kg] 
- Fuel mixture(s) used 
- Energy share of fuel mixtures [%]

94

Input data needed



Conclusions
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• Practical use of COPERT features
• Calculation of GHG and other pollutants (precursors, fugitives) 

emissions
• Import/export of input data with Excel 
• Export of emissions results to Excel



Day 4
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Thursday 26 September 2024

15:00 – 17:00 Bonn Time 
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Session 6

Higher tier methods for estimating GHG emissions from road transportation
COPERT model: implementation of Tier 2 and Tier 3 methods to estimate GHG 
emissions

Demonstration using COPERT interface with hands-on exercice 

Learning 

objectives

By the end of this session, you will:
1. Build the vehicle database with all categories
2. Understand how to enter data for T1 and T2
3. Know how extracting and exporting the results in

XLS format
4. Know how exploring and using T1 and T2 results
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Hands-on Exercise to estimate GHG emission with Tier 2

1. - Calculation of road transport emissions with Tier 2

2. - Use of data set from the Niger vehicle stock (2016 –

2020)

3. - Use of average annual mileage travelled by each 

category of vehicles in Niger

Online Demonstration using COPERT 



99

Hands-on Exercise to estimate emission with Tier 3

1. Calculation of GHG road transportation emissions with Tier 3
2. Use of data set from the Niger vehicle stock (2016 – 2020)
3. Use of average annual mileage travelled by each category of 

vehicles in Niger
4. Use of traffic activity data (average urban speeds) for the 

different categories of vehicles running in Niger

Online Demonstration using COPERT 



Hands-on exercice 
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Estimation of GHG, precursors and fugitive emissions



Conclusions
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• COPERT does not use Tier 1
• COPERT applies only higher tiers (Tier 2 and Tier 3)
• Accuracy of calculation results and large range of pollutants 

covered
• Required input data and calculation steps for Tier 2 and Tier 3
• Need of development of practical skills to use COPERT



Day 5
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Friday 27 September 2024

15:00 – 17:00 Bonn Time 
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Other key functions of the COPERT model: 
Energy balance of road transportation, GHG emission and 
fuel consumption projections (NDC) 

Learning 

objectives

By the end of this session, you will:
1. Know how COPERT estimates the fuel 

consumption of the vehicle stock 
2. Understand how to set assumptions to build

scenarios for emission projections
3. Understand how to use COPERT to estimate

GHG emission projections based on  different
scenarios 



Hands-on exercises
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Estimation of fuel balance from road transportation



Vehicle stock of NIGER



Assumptions on annual mileage in NIGER

Vehicles Fuels

Assumptions 
Average annual

mileage
(km/y)

Passenger Cars Petrol 8 000 

Diesel 8 000 

Light Commercial Vehicles Petrol 10 000 

Diesel 10 000 

Heavy Duty Trucks Rigid Diesel 13 000 

Heavy Duty Trucks – Articulated Diesel 13 000 

Buses - Coaches Standard Diesel 15 000 

Mopeds 2-stroke Petrol 3 000 



Fuel consumption estimation by COPERT using vehicle
stock data and assumptions on mileage for NIGER

Years 2016 2017 2018 2019 2020

Passenger Cars 4 128 3 952 3 666 4 391 4 693
Petrol 2 014 1 929 1 789 2 143 2 290
Small 2 014 1 929 1 789 2 143 2 290

Diesel 2 113 2 023 1 877 2 248 2 403
Small 2 113 2 023 1 877 2 248 2 403

Light Commercial Vehicles 930 895 836 996 1 050
Petrol 371 357 334 395 419
N1-I 371 357 334 395 419

Diesel 559 538 503 602 631
N1-I 559 538 503 602 631

Heavy Duty Trucks 4 249 4 101 3 750 4 449 4 787
Diesel 4 249 4 101 3 750 4 449 4 787
Rigid 7,5 - 12 t 1 384 1 298 1 204 1 491 1 614
Articulated 34 - 40 t 2 865 2 803 2 546 2 958 3 174

Buses 2 296 2 219 2 083 2 435 2 532
Diesel 2 296 2 219 2 083 2 435 2 532
Coaches Standard <=18 t 2 296 2 219 2 083 2 435 2 532

L-Category 582 559 516 624 666
Petrol 582 559 516 624 666
Mopeds 2-stroke <50 cm³ 582 559 516 624 666

Total 12 185 11 726 10 852 12 895 13 729



NIGER: Energy balance



International Data sources of fuel consumption



Data Comparison: COPERT and Statistics
Years

Fuels
2016 2019 2020

Assumptions on 
Average Annual Mileage

(TJ) (TJ) (TJ) (km/y)

R
es

u
lt

s
o

f 
C

O
P

ER
T 

ca
lc

u
la

ti
o

n Passenger Cars Petrol 2 014 2 143 2 290 8 000 

Diesel 2 113 2 248 2 403 8 000 

Light Commercial Vehicles Petrol 
371 395 419 

10 000 

Diesel 559 602 631 10 000 
Heavy Duty Trucks Rigid Diesel 1 384 1 491 1 614 13 000 
Heavy Duty Trucks –

Articulated Diesel 2 865 2 958 3 174 13 000 

Buses - Coaches Standard Diesel 2 296 2 435 2 532 15 000 
Mopeds 2-stroke Petrol 582 624 666 3 000 

Road 
Transportation 

Totals

COPERT 12 185 12 895 13 729 

AIE data 15 144 16 394 15 818 Source 1: IEA, website

UN 
statistics 14 583 14 669 Source 2: UNSD, website

National 
Statistics 15 047 16 287 15 742 Source 3: Energy Balance, Niger, 2021, MPEER website

Difference = National -
Copert

TJ 2 863 3 391 2 014 

ktep 68  81  48 
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Estimation of emission projections for different 
scenarios of road transportation



Assumptions for road transportation scenarios 

▪ Vehicle stock: number of vehicles registered (new, 
used) per category, fuel , age, technology (new 
transportation policy, vehicle emission regulations , 
vehicle incentives, etc.)

▪ Vehicle use: public transportation policy, fuel pricing, 
regulations, inspection & maintenance, 

▪ Road traffic characteristics : road type, speed 
mileage, hot and cold start (infrastructure, traffic
managment plan, etc.), 



Current vehicle stock 

Category Fuel Segment
Euro 

Standard
1990 1995 2000 2005 2010 2015 2020 2024 2030 2035 2040

Passenger Cars Petrol Small Euro 1 X X X X X X X X ? ? ?

Passenger Cars Petrol Medium Euro 1 X X X X X X X X ? ? ?

Passenger Cars Petrol Large-SUV-Executive Euro 1 X X X X X X X X ? ? ?

Passenger Cars Diesel Small Euro 1 X X X X X X X X ? ? ?

Passenger Cars Diesel Medium Euro 1 X X X X X X X X ? ? ?

Passenger Cars Diesel Large-SUV-Executive Euro 1 X X X X X X X X ? ? ?

Light Commercial Vehicles Petrol N1-I Euro 1 X X X X X X X X ? ? ?

Light Commercial Vehicles Diesel N1-I Euro 1 X X X X X X X X ? ? ?

Buses Diesel Urban Buses Midi <=15 t Euro I X X X X X X X X ? ? ?

Buses Diesel Urban Buses Standard 15 - 18 t Euro I X X X X X X X X ? ? ?



Vehicle stock evolution

Category Fuel Segment Euro 
Standard

1990 1995 2000 2005 2010 2015 2020 2024 2030 2035 2040

Passenger Cars Petrol Small Euro 1 X X X X X X X X XX XXX XXX

Passenger Cars Petrol Medium Euro 1 X X X X X X X X X XXX XXX

Passenger Cars Petrol Large-SUV-Executive Euro 1 X X X X X X X X x x x

Passenger Cars Diesel Small Euro 1 X X X X X X X X XX XXX XXX

Passenger Cars Diesel Medium Euro 1 X X X X X X X X X XXX XXX

Passenger Cars Diesel Large-SUV-Executive Euro 1 X X X X X X X X x x x

Light Commercial Vehicles Petrol N1-I Euro 1 X X X X X X X X X X X

Light Commercial Vehicles Diesel N1-I Euro 1 X X X X X X X X X X X

Buses Diesel Urban Buses Midi <=15 t Euro I X X X X X X X X XXX XXXX XXXX

Buses Diesel Urban Buses Standard 15 - 18 t Euro I X X X X X X X X XXX XXXX XXXX



Development of road transportation scenarios 



Vehicle Stock evolution without new technology (standard)

Category Fuel Segment Euro 
Standard

1990 1991 1992 1993 1994 1995 1996 1997 1998 1999 2000 2001 2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013 2014 2015 2016 2017 2018 2019 2020 2021 2022 2023 2024 2025 2026 2027 2028 2029 2030 2031 2032 2033 2034 2035 2036 2037 2038 2039 2040

Passenger Cars Petrol Small Euro 1 100 101 101 102 102 103 103 104 104 105 105 106 106 107 107 108 108 109 109 110 110 111 112 112 113 113 114 114 115 116 116 117 117 118 118 120 121 122 123 125 126 127 128 130 131 132 134 135 136 138 139

Passenger Cars Petrol Medium Euro 1 120 121 121 122 123 124 124 125 126 127 127 128 129 130 130 131 132 133 134 134 135 136 137 138 139 139 140 141 142 143 144 144 145 146 147 149 150 152 153 155 156 158 159 161 162 164 166 167 169 171 172

Passenger Cars Petrol Large-SUV-Executive Euro 1 10 10 10 10 10 10 10 10 10 10 10 10 10 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 12 12 12 12 12 12 12 12 12 12 12 12 12 12

Passenger Cars Diesel Small Euro 1 30 30 30 30 31 31 31 31 31 31 32 32 32 32 32 32 32 33 33 33 33 33 33 34 34 34 34 34 34 35 35 35 35 35 36 36 36 37 37 37 38 38 38 39 39 40 40 40 41 41 42

Passenger Cars Diesel Medium Euro 1 160 161 162 163 164 165 166 167 168 169 170 171 172 173 174 175 176 177 178 179 180 181 183 184 185 186 187 188 189 190 191 193 194 195 196 198 200 202 204 206 208 210 212 214 217 219 221 223 225 228 230

Passenger Cars Diesel Large-SUV-Executive Euro 1 90 90 91 91 91 92 92 93 93 93 94 94 94 95 95 96 96 96 97 97 97 98 98 99 99 99 100 100 101 101 101 102 102 103 103 103 103 103 103 104 104 104 104 104 104 104 104 104 105 105 105

Light Commercial 
Vehicles

Petrol N1-I Euro 1 10 10 10 10 10 10 10 10 10 10 10 10 10 10 10 10 10 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 12 12 12 12

Light Commercial 
Vehicles

Diesel N1-I Euro 1 90 90 91 91 92 92 93 93 94 94 95 95 96 96 97 97 97 98 98 99 99 100 100 101 101 102 102 103 103 104 105 105 106 106 107 107 108 108 109 109 110 110 111 112 112 113 113 114 114 115 115

Buses Diesel Urban Buses Midi <=15 t Euro I 30 30 30 30 30 31 31 31 31 31 31 31 31 32 32 32 32 32 32 32 32 33 33 33 33 33 33 33 34 34 34 34 34 34 34 35 35 35 36 36 36 37 37 38 38 38 39 39 39 40 40

Buses Diesel
Urban Buses Standard 15 
- 18 t

Euro I 50 50 50 51 51 51 51 51 52 52 52 52 52 53 53 53 53 54 54 54 54 54 55 55 55 55 55 56 56 56 56 57 57 57 57 58 58 59 60 60 61 61 62 63 63 64 65 65 66 66 67

Scenario1



Vehicle stock evolution with new technology (Standard)

Category Fuel Segment Euro Standard 1990 1991 1992 1993 1994 1995 1996 1997 1998 1999 2000 2001 2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013 2014 2015 2016 2017 2018 2019 2020 2021 2022 2023 2024 2025 2026 2027 2028 2029 2030 2031 2032 2033 2034 2035 2036 2037 2038 2039 2040

Passenger Cars Petrol Small Euro 1 100 101 101 102 102 103 103 104 104 105 105 106 106 107 107 108 108 109 109 110 110 111 112 112 113 113 114 114 115 116 116 117 117 118 118 118 117 117 116 116 115 114 114 113 113 112 112 111 110 110 109

Passenger Cars Petrol Small Euro 5 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 100 101 101 102 102 103 103 104 104 105 105 106 106 107 107 108

Passenger Cars Petrol Medium Euro 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Passenger Cars Petrol Medium Euro 5 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Passenger Cars Petrol Large-SUV-Executive Euro 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Passenger Cars Petrol Large-SUV-Executive Euro 5 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Passenger Cars Diesel Small Euro 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Passenger Cars Diesel Small Euro 5 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Passenger Cars Diesel Medium Euro 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Passenger Cars Diesel Medium Euro 5 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Passenger Cars Diesel Large-SUV-Executive Euro 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Passenger Cars Diesel Large-SUV-Executive Euro 5 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Passenger Cars Battery electric Small Euro 6 a/b/c 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Passenger Cars Battery electric Medium Euro 6 a/b/c 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Passenger Cars Battery electric Large-SUV-Executive Euro 6 a/b/c 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Light Commercial Vehicles Petrol N1-I Euro 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Light Commercial Vehicles Petrol N1-I Euro 5 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Buses Diesel Urban Buses Midi <=15 t Euro I 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Buses Diesel Urban Buses Midi <=15 t Euro V 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Buses Diesel Urban Buses Standard 15 - 18 t Euro I 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Buses Diesel Urban Buses Standard 15 - 18 t Euro V 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

Scenario2



Vehicle Mileage evolution

Scenario 1 & 2



Projection of GHG, Precusrsors and Fugitives 
emissions for road transportation

Online Demonstration with COPERT 
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Closing session

• Lessons learnt from the Webinar

• Next steps

• Closing remarks by the UNFCCC Secretariat



Thanks for your participation and interest in COPERT  


